
AVTMMTO210 
Rev 7 

Sept 2013 
 

 
 
 
 
 
 

 
 
 

Instruction Manual 
for 

Transformer Ohmmeter 
DC Winding Resistance Test Set 

 
 MTO210 

 
Catalog Number MTO210 

 
 
 
 

HIGH-VOLTAGE EQUIPMENT 
 
 
 

Read this entire manual before operating. 
 
 

 
 
 
 
 
 

M 
 
Valley Forge Corporate Center 
2621 Van Buren Avenue 
Norristown, PA 19403-2329 
U.S.A. 
 
610-676-8500 

www.megger.com 
 
  



 
  



 
 
 
 
 
 
 
 
 

 
 
 
 
 

Transformer Ohmmeter 
DC Winding Resistance Test Set 

 
 

 MTO210  
 

 
 
 
 
 
 
 
 



Copyright© 2011 by Megger. All rights reserved. 
 
The information presented in this manual is believed to be adequate for the intended use of the product. 
If the product or its individual instruments are used for purposes other than those specified herein, 
confirmation of their validity and suitability must be obtained from Megger. Refer to the warranty 
information below. Specifications are subject to change without notice. 
 
 
WARRANTY 
 
Products supplied by Megger are warranted against defects in material and workmanship for a period of 
one year following shipment. Our liability is specifically limited to replacing or repairing, at our option, 
defective equipment. Equipment returned to the factory for repair must be shipped prepaid and insured. 
Contact your MEGGER representative for instructions and a return authorization (RA) number. Please 
indicate all pertinent information, including problem symptoms. Also specify the serial number and the 
catalog number of the unit. This warranty does not include batteries, lamps or other expendable items, 
where the original manufacturer’s warranty shall apply. We make no other warranty. The warranty is 
void in the event of abuse (failure to follow recommended operating procedures) or failure by the 
customer to perform specific maintenance as indicated in this manual. 
 
 
M 
 
Valley Forge Corporate Center 
2621 Van Buren Ave 
Norristown, PA 19403-2329 
 
610-676-8500 (Telephone) 
610-676-8610 (Fax) 
 
www.megger.com 
 



 

 
AVTMMTO210 Rev 7 Sept 2013 

i 

 
Table of Contents 

 

1  Getting to know the MTO210 ........................................................................................................................... 1 
Product Overview ................................................................................................................................................ 1 
Top Panel Controls .............................................................................................................................................. 3 

2  Safety ...................................................................................................................................................................... 7 
Safety is the responsibility of the user ............................................................................................................... 7 
General Safety Precautions ................................................................................................................................. 8 
Input Power Precautions ..................................................................................................................................... 9 

3  Preparing for a Test ........................................................................................................................................... 11 
Site Preparation .................................................................................................................................................. 11 
Making Circuit Connections ............................................................................................................................ 11 

4  Operating the MTO210 .................................................................................................................................... 15 
Description of Test Sequence ......................................................................................................................... 15 

5  Transformer Testing ......................................................................................................................................... 25 
Winding Resistance Testing ............................................................................................................................. 25 
Testing a Single-Phase Transformer ............................................................................................................... 26 
Testing Delta Configured Windings ............................................................................................................... 33 
Testing Transformers with Tap Changers ..................................................................................................... 35 
Testing Voltage Regulators .............................................................................................................................. 36 
Demagnetizing a Transformer ......................................................................................................................... 39 

6  MTO210 Series PowerDB Lite ....................................................................................................................... 41 
Introduction ....................................................................................................................................................... 41 
Software Installation ......................................................................................................................................... 42 
Using PowerDB Lite ......................................................................................................................................... 45 
Frequently Asked Questions (FAQ’s) ............................................................................................................ 52 

7  Service ................................................................................................................................................................. 53 
Maintenance ....................................................................................................................................................... 53 
Fuse Replacement ............................................................................................................................................. 53 
Calibration .......................................................................................................................................................... 54 
Repairs ................................................................................................................................................................. 55 
ERROR CODES .............................................................................................................................................. 56 

8  Parts List and Optional Accessories ............................................................................................................... 63 

9  Specifications ...................................................................................................................................................... 65 



 

AVTMMTO210 Rev 7 Sept 2013 
ii 

List of Figures 
 

MTO210 Transformer Ohmmeter Test Set.................................................................................................... iii 

Figure 1:  MTO210 Front Panel ........................................................................................................................ 3 

Figure 2:  Single Winding Measurement ......................................................................................................... 26 

Figure 3:  Dual-Winding Test ........................................................................................................................... 28 

Figure 4:  Reading obtained is per phase, Resistance of A-N Winding ..................................................... 31 

Figure 5:  Reading obtained is between pairs of terminals, Resistance of A and B Windings ................ 32 

Figure 6:  Reading is between pairs of terminals. Resistance of A in parallel with B+C windings ........ 32 

Figure 7:  Odd Position Tap ............................................................................................................................. 36 

Figure 8:  Even Position Tap ............................................................................................................................ 36 

Figure 9:  Connection to a Regulator .............................................................................................................. 37 

 

 
 
 



 
 

 
AVTMTO210 Rev 7 Sept 2013 

iii 

Upon Receipt of Product 

Prior to operation, check for loosened hardware or damage incurred during 
transit. If these conditions are found, a safety hazard is likely, DO NOT attempt 
to operate equipment. Please contact Megger as soon as possible. 

 

MTO210 Transformer Ohmmeter Test Set 

  



 

AVTMMTO210 Rev 7 Sept 2013 
iv 

 

 

 

 

 

 

 

 

 

 

 

M 
 



 

 
AVTMMTO210 Rev 7 Sept 2013 

1 

1  
Getting to know the MTO210 

Product Overview 

The Megger Transformer Ohmmeter is a line-operated, field-portable instrument 
designed specifically to measure the DC resistance of all types of magnetic 
windings safely and accurately. 

Its predominant use is the measurement of the DC resistance of all types of 
transformer windings within the defined ranges of current and resistance. It can 
also test rotating machine windings and perform low-current resistance 
measurements on connections, contacts and control circuits. 

Four features are combined to make this instrument unique: dual measurement 
and current injection, on-load tap-changer testing, automatic discharge and 
demagnetization.. 

The dual set of potential inputs, simultaneously measure the resistance of the 
primary and secondary windings of a single- or three-phase transformer. The 
dual reading characteristic will speed up the measurement when current leads are 
driving more than one winding. 

The Transformer Ohmmeter is extremely useful when testing the windings and 
contact resistance on tap-changers with make-before-break contacts and voltage 
regulators. A warning light will flash and the internal shutdown circuit will be 
triggered if the tap-changer contacts have a break before make event. This action 
checks for pitted or misaligned contacts and indicates such events. 

Likewise users are protected by the shutdown circuit safety feature: any 
inadvertent disconnection of a test lead or loss of power to the instrument will 
safely and quickly discharge the energy stored within the test sample. 

The MTO210 has an added post test feature. At the end of a transformer test, 
the instrument has a demagnetization function. This function will cycle thru the 
transformer with alternating DC current. At the end of 8 cycles, the transformer 
core is demagnetized. 

The Transformer Ohmmeter's wide resistance range (1 micro-ohm to 1999 
ohms) gives a high degree of resolution for even the lowest winding resistance 
tested. 
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Features include: 

 Direct digital reading saves time, no manual balancing is required. 

 Built-in discharge circuit safely discharges the specimen when test is 
completed, if lead accidentally disconnects, or if power is lost. 

 Test indicator light gives a visual indication of either a charged or discharged 
specimen, even if power to the instrument is lost. 

 Two independent measuring channels allow simultaneous testing of primary 
and secondary windings or measurement of two phases at a time. 

 The sensitive tap-changer test circuitry monitors the contact operation of on-
load tap-changers for their correct make-before-break sequence. If an open 
circuit condition exists, the instrument shuts down immediately. 

 Electronically generated and patented regulated current supply overcomes 
high-inductance transformers quickly, allowing fast measurements to be 
taken. Display of measurement occurs only after test current stabilizes. 

 Wide resistance range is suitable for testing a wide variety of transformers. 

 Current ramp-up mode continuously tests input compliance voltage and sets 
the maximum current based on the specific test load. 

 Lightweight and portable, the MTO is ideal for use in workshop or 
substation environments. 

 Over temperature protection provides automatic current shutdown and 
indication to prevent instrument damage. 

 Meets the requirements of both the European EMC and Low Voltage 
Directives. 

It is recommended that the user becomes familiar with the MTO before making 
any connection to a transformer. 
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Top Panel Controls 

 

Figure 1: MTO210 Front Panel 

 

Input AC Power Module: 

This module is an IEC320 interface to the mains power. The module has an 
integrated switch, fuse holder and input filter module. Above the module are the 
voltage, frequency and power requirements for the product. Below the module are 
the fuse type and ratings based on the input voltage used. The green light on the 
right side of the module illuminates when power is ON. 

0, OFF position 

- , ON position 

 

Output Current Terminals 

These connections are used to connect to the transformer winding(s) and pass the 
DC power into the transformer winding for testing and demagnetization. The 
connection is capable of supplying up to 50 volts DC and up to 10 amps current. 
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Input Voltage V1 

These connections are used to connect a transformer winding for input voltage 
measurement. The instrument will automatically calculate the resistance of this 
input in combination with the current source. The connectors are also used as a 
path for current to flow during discharges. Voltage leads shall always be used in 
conjunction with current leads. 

 

Input Voltage V2 

These connections are used to connect a second transformer winding for input 
voltage measurement. The instrument will automatically calculate the 
resistance of this input in combination with the current source. The connectors 
are also used as a path for current to flow during discharges. Voltage leads 
shall always be used in conjunction with current leads. 

 

Earth/Ground Lug 

This connection is used to connect a transformer under test to earth ground for 
safety. The transformer and the MTO shall be at the power ground/earth 
potential when being operated. 

 

Emergency Shut Down Switch 

This switch, when pushed will disable the source power supply and 
automatically discharge the transformer. The instrument is continuously 
monitoring this switch in the event of an emergency. If the switch is engaged, 
no testing can commence. 

 

Current Set Switch 

This switch is used to control the amount of current the instrument will use to 
test a transformer.  

Symbol represents the maximum output level of test current. 

 

Warning Beacon Connector 

When the Warning Beacon is attached to the connector, the user will have a 
more visible indication of the activation mode of the MTO. 

 

Break Before Make INDICATOR  

During testing, the unit will indicate disruptions in the current loop. During 
testing of On Load tap changers, this indication will signify that a faulty break 
before make condition has occurred. 

 

USB Interface 

Not accessible at this time 
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Maintenance Port 

This port is provided for software upgrades and diagnostics, the interface 
panel can be removed and an Ethernet connection is available to attach the 
instrument externally to a PC. Port is NOT network compatible. This product is 
not intended for network use.   

 

RS232 Connection 

This connection is used for printing to a thermal 4” printer and/or transferring 
data from MTO to a user PC.   

 

Remote Control Switch 

This connector is used to interface with a remote switch. This switch is 
primarily used when the system is used for testing On Load Taps of a 
transformer 

The Remote Control Switch can remotely start the MTO test and store multiple 
resistances reading for tap changes. The storage function in remote mode is 
sequential and occurs during a continuous resistance test. The unit will also 
store break before make events in local storage. 

 

Interlock Connections 

These connections are used in the event that testing requires lockout 
mechanisms from the transformer. If the Interlock connection is open, the unit 
will not be capable of going into Test Mode. If the interlock is broken during 
test, the unit will automatically shutdown and discharge an energized 
transformer. Further testing will be prohibited. 

Data Output Mode Switch 

 

 
MTO will Print and Save Data 

 
MTO will Save Data 

 
MTO will Print Data 

MTO will just Display Data 

Function Mode Switch 

 

MTO is in Test Mode 

 
MTO is in Storage Review Mode 

 MTO is in Set Date and Time Mode 

 
MTO is in select Date Format Mode 
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IDLE STATE - When pushed the unit will start a test 
on a transformer. This will only occur if the 
instrument is in Test Mode (see Function Mode 
Switch above). 

The TEST INDICATOR above the button will 
illuminate during the test. 

TEST STATE – When pushed the unit will stop a 
test on a transformer, maintain the results on the 
screen. It will save and/or print the results 
dependent on the Data Output Mode Switch.  

 
When pushed will stop testing and discharge the 
transformer. The DISCHARGE INDICATOR to the 
left will illuminate during the discharge cycle. 

 

When pushed will perform a transformer 
demagnetization. The DEMAG INDICATOR to the 
right will illuminate during the demagnetization 
cycle. 

 
When pushed, the unit will acknowledge data entry, 
displayed messages and during test mode, save 
data presented on the display.  

 

Symbol highlights that the  button will PRINT 
the test results out the RS232 port when pushed 
and in Storage Review Mode. 

In ready mode,  button will change the 
sensitivity of the current transition detection 
sensitivity. Off is default. 

 

Symbol highlights that the   button will give the 
user the ability to DELETE the last recorded test in 
memory. If pressed a second time, the unit will give 
the user the ability to delete all tests in memory. If 
pressed a third time the unit will no longer be in the 
delete function.  

In ready mode,   button turn toggle ON/OFF the 
OHM2 display. 
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2  
Safety 

Safety is the responsibility of the user 

Only qualified and trained operators should operate the MTO system. Operator 
must read and understand this entire Instruction Manual prior to operating the 
equipment. Operator must follow the instructions of this Instruction Manual and 
attend the equipment while the equipment is in use. In the event of equipment 
malfunction, the unit should immediately be de-energized and returned to 
Megger for repair.  

“The Safety precautions herein are not intended to replace your Company’s 
Safety Procedures. Refer to e.g. IEEE 62-1995/IEEE C57.152 and IEEE 510 - 
1983, IEEE Recommended Practices for Safety in High-Voltage and High-
Power Testing, for additional information.” 

 

F 
WARNING 

When applying current to a transformer with very high 
inductance, additional care should be taken not to remove current 
or voltage leads while current is still flowing. This causes an 
extremely high voltage to develop across the point where current 
is broken. Under certain conditions, this voltage could prove to 
be lethal.  

The Megger Transformer Ohmmeter has built-in safety protection thru the 
VOLTAGE POTENTIAL LEADS. Voltage leads shall always be connected in 
parallel with the current leads.  

Example: If a current lead is disconnected while current is flowing through the 
transformer, the current will flow through the alternate path of the 
potential lead without damage to instrument or electrical shock to 
operator. 

F 
WARNING 

It is very important not to connect any leads on top of or too close 
to one another. Take the necessary precautions to assure one 
lead falling off will not take a second lead with it.  
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General Safety Precautions 

The MTO and the Unit Under Test (UUT) should both be considered as sources 
of instantaneously lethal levels of electrical energy. Observe the following safety 
precautions: 

 Observe all safety warnings on the equipment. They identify areas of 
immediate hazard that could result in injury or death. 

 Use this equipment only for the purposes described in this manual. Observe 
strictly the Warning and Caution information provided in this manual. 

 Treat all terminals of high-voltage power equipment systems as potential 
electric shock hazards. Use all practical safety precautions to prevent contact 
with energized parts of the equipment and related circuits. 

 Use suitable barriers, barricades and/or warnings to keep persons not directly 
involved with the work away from test activities. 

 Never connect the test equipment to energized equipment. 

 Do not use in an explosive atmosphere.  

 Use the grounding and connection procedures recommended in this manual. 
Always disconnect test leads from power equipment before attempting to 
disconnect them at the test set. The ground connection MUST be the first 
made and removed last. Any interruption of the grounding connection can 
create an electrical shock hazard. 

 Personnel higher than 5 feet should follow proper tie off safety requirements. 

 Personnel should use proper safety gear to prevent bodily harm. 

 Personnel using heart pacemakers should obtain expert advice on the 
possible risks before operating this equipment or being close to the 
equipment during operation. 

 Fuse selection is dependent on input voltage. 230VAC uses 3.15 amp fuses 
and 120VAC uses 6.3 amp fuses.  

F 
WARNING 

No user serviceable parts inside! Refer all 
servicing to the factory or a qualified authorized 
service company!  
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G 
CAUTION 

Use only factory supplied mains cord! 
Mains cord shall not be substituted! 

Input Power Precautions 

This instrument operates from a single-phase, sine wave, power source. It has a 
three-wire power cord and requires a two-pole, three-terminal (live, neutral, and 
ground) type input source. The voltage to ground from the live pole of the 
power source must be within the following rated operating voltage: 

For Cat. No MTO210:  120/230 V  10%, single-phase sine, 50/60  2 Hz 

The neutral pole must be at ground potential. Before making connection to the 
power source, determine that the instrument rating matches the voltage of the 
power source. The power input plug must be inserted only into a mating 
receptacle with a ground contact. 

F 
WARNING 

Do not bypass the grounding connection. Any interruption of the 
grounding connection can create an electric shock hazard. 
Determine that the receptacle is properly wired before inserting 
the plug.  

The control circuits of the instrument are protected by two mains circuit fuses. 
These fuses are located in the ON/OFF switch module and are replaceable by 
the operator. To avoid electric shock and fire hazard, use only the fuse specified 
in Section 8 Parts List and Optional Accessories, that is identical in respect to type, 
voltage rating, and current rating. A detailed procedure for Fuse Replacement is 
defined in Section 7 - Service. 

F WARNING 
Before replacing the fuses, disconnect the power 
input plug from the live power source. 
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3  
Preparing for a Test 

Site Preparation 

Choose a location that meets the following conditions: 

 The location is as dry as possible. 

 There is no flammable material stored in the vicinity. 

 The test area is adequately ventilated. 

 Be sure all equipment is de-energized and all terminals of the Unit Under 
Test (UUT) are accessible. Erect suitable safety barriers to protect the 
operator from traffic hazards and to prevent intrusion by unauthorized 
personnel. User provided Warning lights are recommended. 

 Verify that the Local station ground is intact and has impedance continuity to 
earth. 

Making Circuit Connections 

Connections should be made in the order as listed below. 

1. Ground. Use the Megger supplied Safety Ground Cable (15 ft (4.6 m)) to 
connect the MTO Wing Nut Ground Terminal directly to Local Station 
Earth Ground. Ensure that the Transformer chassis also has a low 
impedance connection to Local Station Earth ground potential. 

2. Input Power Source Ground. Input Power Source Ground Terminal 
should be less than 100 milliohms of impedance to Local Station Earth 
Ground. 

3. Connect the Input Power Cord. Before making this connection, insure 
the Input Power Source meets the requirements as listed in Section 2 Safety 
and Section 9 Specifications. Also make sure that the ON/OFF switch 
(Figure 1) is in the OFF position. Connect the input power cable to the 
MTO first, then to the power source. At this time, leave the ON/OFF 
switch in the OFF position. 
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4. Connect the Serial Cable (optional). If the user chooses to use an 
external printer or PC, using PowerDB Lite PC software, then connect 
the serial cable between the MTO and the printer or PC at this time. 

5. Connect the Remote Control cable (optional). If the user chooses to 

operate the Test Button  of the MTO from a remote distance then, 
connect the RCC cable at this time. 

6. Connect Warning Beacon (optional). If the user chooses to operate 
the Warning Beacon then, connect the WBC cable at this time and place 
the beacon in a conspicuous location. 

7. Connect Interlock Switch. The MTO has an external interlock switch 
feature. Connect the external Interlock Switch via banana jack 
connection to the interlock input jacks on the front panel. The interlock 
switch function is a fail open, therefore if not used, an interlock jumper 
shall be placed in the jacks. If the circuit is open “IntLoc” will be 
displayed at the middle LCD. 

8. Connect the I and V leads (to the MTO end only at this time). With 
the clamps disconnected from the UUT, connect the I and V cables to 
the MTO at this time. Be sure that all plugs are fastened securely to the 
MTO so they will not become loose even in the event of the operator 
inadvertently tripping over the current leads. 

MTO210 is programmed to read two voltage inputs at all times. If a 
voltage input is not used, the high impedance input characteristics of the 
input cause the unit to give readings that are not zero. If a jumper is 
installed, the reading will be very low. 

9. Connecting to the Transformer. When testing high-voltage 
transformers, caution must be used at all times and all safety precautions 
followed. Read, understand, and employ all safety precautions and circuit 
connections described in Sections 2 Safety and Section 3 Preparing for Test. 

F 
WARNING 

Ensure that the transformer to be tested is completely 
de-energized. Check every winding. Ensure that all 
terminals of the transformer are disconnected from line 
or load at the transformer. Connections to ground may 
be left in place. 

 

F 
WARNING 

For all testing as described herein, care shall be taken 
to ensure any and all unused clamps shall be isolated 
from each other, from ground, and from personnel. 
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At this time, make the connections to the Transformer Under Test (TUT), as 
described in the applicable section of Section 5, Connecting to the Transformer Under 
Test. 
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4  
Operating the MTO210 

When testing high-voltage transformers, caution must be used at all times and all 
safety precautions followed. Read, understand, and employ all safety precautions 
and circuit connections described in Section 2 Safety and Section 3 Preparing for 
Test. 

F 
WARNING 

Ensure that the transformer to be tested is completely 
de-energized. Check every winding. Ensure that all 
terminals of the transformer are disconnected from line 
or load at the transformer. Connections to ground may 
be left in place. 

 

F 
WARNING 

For all testing as described herein, care shall be taken 
to ensure any and all unused clamps shall be isolated 
from each other, from ground, and from personnel. 

 

F 
EMERGENCY SHUTDOWN PROCEDURE 

Press red EMERGENCY TEST OFF push button  
or switch power off. 

Description of Test Sequence 

Once all the precautions and steps of Sections 2 Safety and 3 Prepare for Test are 
complete, and the connections to the Transformer Under Test (TUT) have been 
made, then the input switch may be switched to the ON position. 

 
 

0, OFF position 

- , ON position 

The MTO is operated by using the keypad on the front panel. On power up, a 
beep sound will occur, the test set performs a self-test check, and all hardware 
and software variables are initialized.  
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INITIALIZATION FUNCTION 

The MTO performs startup diagnostics to assure the internal hardware is 
operational before testing transformers. 

If an error code is displayed that is uncorrectable, return the instrument to 
Megger or an authorized service center for repair. Refer to Section 7 Service for 
repair instructions. If no errors are detected, the resistance and current displays 
will present dashes (-). 

TEST FUNCTION 

After a successful initialization function is completed, the user has the ability to 
go into any of four user functions. This section describes the TEST 
FUNCTION in detail. 

1. Set the Data Output Mode Switch to the desired mode.  

 

2. Set the Function Mode Switch to TEST mode.  

 

3. Set the Current Range required for test.  

 

4. The current display window (I) will flash ready before a test sequence is 
initiated.  

5. The OHM 1 display window will display the locally stored temperature 
that the unit will store with the resulting data for all subsequent tests. 

Press  and  to change the transformer winding temperature at 
the time of test. 

6. The OHM 2 display window will display the Current Transition time 
sensitivity and if OHM 2 display is turned ON or OFF during testing. 
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Press   to change the transition sensitivity. 0 is off and the higher the 
number, the more sensitive the circuit will be for current transitions. 

Press   to turn ON or OFF the OHM 2 display during testing. 

7. locally stored temperature that the unit will store with the resulting data 

for all subsequent tests. Press  and  to change the transformer 
winding temperature at the time of test. 

8. Press  and the unit will apply power to the transformer and attempt 
too charge the transformer to the maximum current set level. Once the 
current has stabilized, the unit will calibrate all inputs and take resistance 
readings continuously. 

9. Press  during testing and the unit will save and/or print the 
displayed data (based on the setting of the Data Output Mode Switch). 
This button makes it possible to take multiple readings such as an on 
load tap changer test. The unit will display the test number in the current 
display and Saved in Ohm 2 display for 2 seconds to acknowledge the 
data saved. 

10. Press  and the unit will turn off power to the transformer, store 
and/or print the data (based on the setting of the Data Output Mode 
Switch and display the data on the LCD display for review. 

The data will stay on the LCD until another function or  is selected. 

DISCHARGE FUNCTION 

 

This button, when pushed will stop testing and discharge the 
transformer. The Discharge Indicator to the left will illuminate during 
the discharge cycle. No data is stored in the memory and/or output 
to printer. 

The discharge of a transformer after testing is critical to prevent excessive 
voltage buildup across the transformer bushings upon removal of current. When 
the current source is disconnected, the energy in a transformer will continue to 
flow. If there is high impedance (air), the voltage across the inductor will increase 
until there is a current path found for the energy. This can be either an internal 
or external current path. It is possible to attach a shorting cable across the 
transformer bushings before the current source is turned off. Since the short has 
very little resistance, the circulating current thru the transformer and the short 
may continue for a very long period of time. The MTO discharge circuitry is 
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built-in. It will automatically initiate when the current source is disconnected 
from the transformer. It will also provide visual indication of discharging.  

DEMAGNETIZATION FUNCTION 

 

This button, when pushed will perform a transformer 
demagnetization. The Demag Indicator to the right will illuminate 
during the demagnetization cycle. 

The demagnetization of a transformer after testing is critical for smooth 
transformer startup. If there is a large residual flux present in the transformer at 
startup, inrush currents on the primary side of the transformer may exceed relay 
settings for shutdown, therefore, it is advantageous to perform demagnetization 
after a winding resistance test sequence has been run and the transformer is 
scheduled back into service. 

The MTO demagnetizes the transformer by automatically magnetizing the core 
of the transformer in the positive and negative direction with multiple cycles of 
reduced current. During the demagnetizations, the unit will display what cycle 
the unit is processing.  

Demagnetization only needs to be accomplished once after all testing is 
complete. CURRENT and VOLTAGE leads should be attached to high side 
windings for more effective demagnetization.   

The demagnetization cycle will take time for completion. It is equivalent to 
taking multiple tests in sequence.   

REMOTE TEST FUNCTION 

The main purpose of this function is to take sequential data to storage during a 
single test. It is useful for tap change testing where multiple resistance values are 
to be read in sequence with no test lead movement. 

1. Connect Remote Control Cable to the remote connector on the front 
panel of the instrument. 

 

2. Power ON (-) the instrument. 

The Unit will detect the Remote Switch and display “rnnt 0/1”. The 0 is 
when the switch is not pushed; the 1 is when the switch is pushed. This is the 
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indicator that you are in Remote Mode and the button is functioning 
properly. 

3. To start a test sequence, press  on the front panel. This will NOT 
cause the test to start but only illuminate the HV Indicator. The Remote 
Indicator will stay off.  

4. The operator will go to the tap changer, verify it is in the correct starting 

position, and then to start the first test, press . 

The Remote Indicator will slow flash to indicate charging. When the Remote 
Indicator goes steady the reading is stable. 

5. Pressing  will cause the stable result to be saved to memory. The 
MTO is always monitoring for a tap change interrupts. 

If a Break Before Make condition occurs the Break Before Make Indicator will 
flash rapidly. 

 
Depending on the length of the break, one of two things will happen. 

1. For short breaks, the unit will rapidly flash, but the system will continue 

to operate and give resistance readings. Press  to acknowledge and 

store the event or press   to delete the event. 

2. For breaks longer than about 200 msecs, the system will automatically 
shut down. The HV Indicator will extinguish and the Discharge Indicator 
and Remote Indicator will flash. 

To extinguish the Break Before Make Indicator, press . 

If no such condition exists the Remote Indicator will start slow flashing again 
until the circuit stabilizes from the tap change and then go steady when this 
setting has stabilized. 

3. Press  to record the reading again and the process continues till all 
transformer taps are tested. 
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STORED DATA FUNCTIONS 

The MTO can save up to 2000 test results to memory for archival purposes. If 
data is stored while testing, the unit can step thru the memory after testing in a 
review process. 

 

1. Set the Data Output Mode Switch into Storage Review Mode. The unit will 
come up with the last data stored in alternate mode. The logged test number 

and time of test will flash on the upper screen. By pressing , the unit 
will display detailed results of current and two resistance values. Pressing 

 will alternate between the two displays. 

NOTE:  If the MTO storage is full, the message “StorAg FULL” will be 
displayed at power up or at first time reviewing data.  

 

2. Press  and  to traverse the stored data. 

3. Press   to print displayed data. 

4. Press   to delete the last stored data from the unit. The unit will ask for 

confirmation with SURE on the OHM1 screen. Press  to confirm deletion. 

5. Press   a second time to delete all stored data from the unit. The unit will 

ask for confirmation with SURE on the OHM1 screen. Press  to confirm 
deletion. 

6. Press   a third time to get out of the delete mode. 

TEST
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SET TIME FUNCTION 

The MTO can set the Time of Day from the front panel interface. Set the 
function mode switch to the Date Time Setting as shown below. 

 

1. Set the Function Mode Switch into set time mode. 

 

2. Use  and  to traverse thru the year, month, day, hour, minute and 
second. The active parameter will blink on and off. 

3. Use  and  to increase or decrease the selected parameter.  

4. Use  to confirm any changes made to selected parameters.  

SET TIME AND DATE FORMAT  

The MTO can change the Date Format.  

 

1. Set the Function Mode Switch to Date Format Mode. 

TEST

TEST



M 
 

AVTMMTO210 Rev 7 Sept 2013 
22 

 

2. Press  and  to traverse from year/month/day to month/day/year to 
day/month/year. 

3. Press  to confirm any changes made to selected parameters.  
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FIRMWARE UPDATE MODE 

The MTO has two processors, commonly referred to as the bottom and top 
processor. Each processor requires software to function properly. This section 
describes the method for changing the firmware on an MTO 

ATTAINING THE LATEST SOFTWARE: 

The best way to attain the latest software is to visit Megger.com. 

Once you are on the site, 

1. Select the country you are located in. 

2. You may have to register to log in on the site. 

3. Select Software Downloads. 

4. Select MTO. There should be a list of software available for download. 

5. Select the latest firmware version available. The software is self contained 
as a ZIP file.  

6. Download the file and run. The software will self extract and run 
automatically.  

7. A Megger Welcome Screen will appear on the PC display. Before moving 
forward connect the PC to the MTO210 via an Ethernet cable.  

8. Follow the instructions on the screen and the software will guide you 
thru the process of selecting the Ethernet Interface, verifying that the 
MTO is connected, power cycling the MTO to synchronize the boot 
loader with the PC, selecting the file for download and actually 
downloading the software.  
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5  
Transformer Testing 

F 
WARNING 

When testing a transformer or regulator, make sure that a good 
ground is placed on the test specimen as shown on all 
connection diagrams.

Winding Resistance Testing 

Winding resistance measurements in transformers are of fundamental 
importance for the following purposes: 

  Calculations of the I2R component of conductor losses. 

  Calculation of winding temperature at the end of a temperature test cycle. 

  As a diagnostic tool for assessing possible damage in the field. 

Transformers are subject to vibration. Problems or faults occur due to poor 
design, assembly, handing, poor environments, overloading or poor 
maintenance. Measuring the resistance of the windings assures that the 
connections are correct and the resistance measurements indicate that there are 
no severe mismatches or opens. Many transformers have taps built into them. 
These taps allow ratio to be increased or decreased by fractions of a percent. Any 
of the ratio changes involve a mechanical movement of a contact from one 
position to another. These tap changes should also be checked during a winding 
resistance test.  

Regardless of the configuration, either star or delta, the measurements are 
normally made phase-to-phase and comparisons are made to determine if the 
readings are comparable. If all readings are within one percent of each other, 
then they are acceptable. Keep in mind that the purpose of the test is to check 
for gross differences between the windings and for opens in the connections. 
The tests are not made to duplicate the readings of the manufactured device 
which was tested in the factory under controlled conditions and perhaps at other 
temperatures. 

Transformer winding resistances are measured in the in order to check for 
abnormalities due to loose connections, broken strands, and high-contact 
resistance in tap changers. Interpretation of results is usually based on a 
comparison of measurements made separately on each phase in the case of a 
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wye-connected winding or between pairs of terminals on a delta-connected 
winding. Comparison may also be made with original data measured in the 
factory. 

Testing a Single-Phase Transformer 

SINGLE-WINDING TEST 

 

Figure 2: Single Winding Measurement 

F WARNING 
Do not disconnect leads until all indicators are OFF! 

PROCEDURE: 

1. Connect line cord to unit and plug into 120 V/230 V socket. 

2. Connect Safety GND cord from Top Panel to Transformer GND. 

3. Set the following conditions: 

a. 

 

Set to TEST position. 
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b.  

 

Set to desired MAXIMUM TEST 
CURRENT. 

c.  

 

Set to desired DATA OUTPUT. 

4. Connect "V1" voltage leads to test specimen winding. Do not clip 
potential leads on the current leads, since this will add contact resistance 
to the measurement. See Figure 2. 
 
Connect current output (I) to test specimen winding. See Figure 2. 

5. Turn power switch "ON" (-).  

6. Press  button to initiate current flow. 

7. The top smaller display indicates current output and the Ohm1 display 
indicates resistance of specimen. 

NOTE For larger transformers, the resistance display should be observed and 
resistance readings taken when the reading stabilizes. The drift in the 
indicated resistance reading is due to the inductance of the transformer. 
For small transformers the drift lasts for only a few seconds; for single-
phase high voltage transformers (500kV), the drift may last for a 
fraction of a minute; for large delta connected transformers the settling 
time may be much longer, see section “Testing Delta Connected 
Windings”.  A 345MVA, 500kV single-phase transformer requires 
approximately 2 minutes for the display to settle. 

8. When measurement is complete, press  to terminate measurement 
and discharge current. Discharge is complete when the discharge 
indicator is off. 

9. Remove the current leads from the transformer. 

10. Remove the potential leads form the transformer. 
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DUAL-WINDING TEST 

This procedure describes the testing of both windings (high and low) on a single-
phase transformer at the same time. 

 

Figure 3: Dual-Winding Test 

F WARNING 
Do not disconnect leads until all indicators are OFF! 

NOTES: It should be carefully noted that the jumper in Figure 3 be connected to 
opposite polarities of transformer to reduce transformer core saturation 
time. 

 If the resistance between the 2 windings is greater than factor of 10, you 
may get a more accurate reading by testing the windings separately. 

PROCEDURE: 

1. Connect line cord to unit and plug into line socket. 

2. Connect Safety GND cord from Top Panel to Transformer GND. 
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3. Set the following conditions: 

a 

 

Set to TEST position. 

b.  

 

Set to desired MAXIMUM TEST CURRENT. 

c.  

 

Set to desired DATA OUTPUT. 

4. Connect "V1" voltage leads input to H1 and H2 terminals of test 
transformer.  See Figure 3. 

5. Connect "V2’ voltage leads input to X1 and X2 terminals of test 
transformer.  See Figure 3. 
 
Connect current leads (I) to test specimen winding. See Figure 3. Add the 
Jumper Cable from H2 to X1. This will allow current to flow from the 
primary winding to the secondary winding. Voltage leads should 
always be placed inside (between) current leads and the 
transformer. See Figure 3. 

NOTE: Always try and keep the polarization of the transformer the same for 
improved transformer charge time. If the positive lead for the current is 
connected to the positive terminal of the primary winding, follow this 
procedure by driving the current from the primary winding H2 jumpered 
to the positive terminal of the secondary winding X1.  

6. Turn power Switch "ON" (-). Press  button to initiate current flow.  

7. The top smaller display indicates current output and the Ohm1 display 
indicates resistance of primary winding and Ohm 2 display indicates the 
resistance of the secondary winding specimen. 

8. When measurement is complete, press  to end the measurement 
and discharge current. Discharge is complete when discharge indicator is 
OFF(0). 
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Temperature Correction 

It may be necessary to convert the resistance measurements to values 
corresponding to the reference temperature in the transformer test report.  

To estimate the winding temperature at the measurement is important. If the 
transformer has winding temperature, use theses readings. If not, the winding 
temperature is assumed to be the same as the oil temperature under the following 
conditions: 

  The transformer has been out of service for at least 3 hours 

  The temperature of the insulating liquid has stabilized, and the difference 
between the top and bottom temperature does not exceed 5ºC. 

If the transformer is measured without oil, the winding temperature is normally 
assumed to be the same temperature as the surrounding air.  

Conversion of Resistance Measurements 

Winding resistance measurements are normally converted to a standard reference 
temperature. 

The conversions are accomplished by the following formula: 

Rs = Rm ( Ts + Tk )/( Tm + Tk ) 

where 

Rs = resistance at desired temperature Ts 

Rm = measured resistance 

Ts = desired reference temperature 

Tm = temperature at which resistance was measured 

Tk = 234.5 (copper) 

Tk = 225 (aluminum) 
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Testing a Three-Phase Transformer 

The following details the different methods to be used in testing three-phase 
transformers. The measurements taken will be for one or two winding(s) at a 
time. Connection diagrams (Figures 4 thru 7) are to be used in conjunction with 
procedure "Single-Phase Transformer Test". The only changes will be placement 
of leads. 

NOTE:  When testing Primary and Secondary windings simultaneously, always 
try and keep the polarization of the transformer the same for improved 
transformer charge time. See Table 1. 

PROCEDURE: 

1. Three-Phase Wye Configured Winding with Neutral 

 

Figure 4: Reading obtained is per phase, Resistance of A-N Winding 

Use the above diagram in conjunction with procedure "Single-Phase 
Transformer Test". 
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2. Three-Phase Wye Configured Winding, No Neutral Brought Out 

 

Figure 5: Reading obtained is between pairs of terminals, Resistance of A and B Windings 

Use the above diagram in conjunction with procedure "Single-Phase 
Transformer Test". 

 

3. Three-Phase, Delta Configured Winding 

 

Figure 6: Reading is between pairs of terminals. Resistance of A in parallel with B+C Windings 

Use the diagram in Figure 6 in conjunction with procedure "Single-Phase 
Transformer Test". 

X3

X1 X2

+

-
I

+

-
V1

+

-
V2



Transformer Testing 
 

 
AVTMTO210 Rev 7 Sept 2013 

33 

Testing Delta Configured Windings 

Testing Delta winding resistance may be a very time consuming procedure, in 
particular LV winding deltas the correct balance time can take up to 30-60 
minutes for a large transformer, which far exceeds the time restriction of many 
tests. 

The method for quickly testing delta configurations requires that both the high 
side and low side be connected in series with the MTO’s current source (see 
connection Table 1). By using both HV and LV windings to magnetize the core, 
the effective test magnetization current increases with the turn ratio. As an 
example, testing the Low Voltage side of a 100/10 kV Yd transformer with dual 
side injection at 10A is the same as testing only the Low Voltage side of that 
same transformer 68 A. Even if only one side of the transformer needs to be 
tested, connecting both high and low windings in series will speed the test up by 
a factor of 10 or more. 

DELTA WINDING RESISTANCE 

Manufacturer’s winding resistance data are usually presented as per winding for 
Y configurations and per terminal pairs for Delta windings. In the rare case that 
manufacturer’s data is presented per winding also for a delta connection, the 
recommendation is to recalculate the numbers to terminal pairs and compare 
with the field measurement results. 

Ravg = Average individual winding resistance 

Rtp = Winding resistance between terminal pirs 

Rtp=Ravg*0.6667 
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TABLE 1. 

EXAMPLES ON TRANSFORMER CONNECTION SCHEMES 
FOR 

INJECTING TEST CURRENT AND MEASURING TWO WINDINGS 
SIMULTANEOUSLY 

Vector Group 
Measurement setup 

Current Connections Meas ch 1 Meas ch 2 

+ Current Jumper - Current  +  -  +  - 

Dd0 
H1 H3-X1 X3 H1 H3 X1 X3 

H2 H1-X2 X1 H2 H1 X2 X1 

H3 H2-X3 X2 H3 H2 X3 X2 

Dyn7 
H1 H3-X0 X1 H1 H3 X0 X1 

H2 H1-X0 X2 H2 H1 X0 X2 

H3 H2-X0 X3 H3 H2 X0 X3 

Dyn1 
H1 H3-X1 X0 H1 H3 X1 X0 

H2 H1-X2 X0 H2 H1 X2 X0 

H3 H2-X3 X0 H3 H2 X3 X0 

YNyn0 
H1 H0-X1 X0 H1 H0 X1 X0 

H2 H0-X2 X0 H2 H0 X2 X0 

H3 H0-X3 X0 H3 H0 X3 X0 

Ynd1 
H1 H0-X1 X2 H1 H0 X1 X2 

H2 H0-X2 X3 H2 H0 X2 X3 

H3 H0-X3 X1 H3 H0 X3 X1 

Dy1 
H1 H3-X1 X2 H1 H3 X3 X2 

H2 H1-X2 X3 H2 H1 X1 X3 

H3 H2-X3 X1 H3 H2 X2 X1 

YNd7 
H1 H0-X2 X1 H1 H0 X2 X1 

H2 H0-X3 X2 H2 H0 X3 X2 

H3 H0-X1 X3 H3 H0 X1 X3 

Dyn5 
H1 H2-X0 X1 H1 H2 X0 X1 

H2 H3-X0 X2 H2 H3 X0 X2 

H3 H1-X0 X3 H3 H1 X0 X3 

Dy11 
H1 H3-X1 X3 H1 H3 X1 X3 

H2 H1-X2 X1 H2 H1 X2 X1 

H3 H2-X3 X2 H3 H2 X3 X2 

Dyn11 
H1 H2-X1 X0 H1 H2 X1 X0 

H2 H3-X2 X0 H2 H3 X2 X0 

H3 H1-X3 X0 H3 H1 X3 X0 
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Testing Transformers with Tap Changers 

Many transformers used today have taps built into them. These taps allow ratio 
to be increased or decreased by a few percent. Any of the ratio changes involve a 
mechanical movement of a contact from one position to another. It is this 
contact that needs to be checked by way of its contact resistance and mechanical 
integrity. 

The contact may go bad for a number of reasons. 

1. Misaligned when manufactured causing insufficient surface contact. Full 
load current overheats contact surface causing it to burn. 

2. Current passing through contact exceeds full load rating. 

3. Tap changing operation failing to have the required "Make Before Break" 
sequence will create internal arcing of contact surface. 

4. An off-load tap changer is switched while on load. Contact surface 
becomes pitted and uneven. 

Tap changers are divided into two types; “On-load” and “Off-load”. The "On-
load" tap changer allows selection of ratio change while the transformer is in 
service. This would mean the ratio of a transformer can be changed while power 
(current) is still passing through it. The most common example of this type of 
"On-load" tap changer is a "Voltage Regulator". 

The MTO is ideally suited to test “On-load” tap changers because the instrument 
can be left ON while changing from tap to tap. This allows the operator to take 
measurements very quickly without discharging, then re-charging the transformer 
for every tap. The MTO will re-balance after every tap change. If the tap is 
defective (open) or if there is even a fraction of time (1mS) where circuit is open, 
the MTO will indicate an open circuit. If the current interruption is longer than 
about 10 ms, the MTO will stop the test and discharge the transformer 
automatically. This gives the operator a clear indication of a possible fault within 
the tap changer. For this OPEN condition, no damage will be done to the 
transformer by the MTO’s DC current. 

The second type of tap changer is the "Off-load". This is not as common as 
“On-load” because in order to change taps, the transformer has to be taken out 
of service or at least disconnected from the load. The MTO will test “Off-load” 
taps, but the transformer must be discharged between tap changes. If the 
transformer is not discharged between tap changes, damage can result in the 
transformer or the test unit  
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Testing Voltage Regulators 

This procedure describes the basic connections to a single-phase regulator. The 
main test for a regulator is the evaluation of the condition of the tap positions. 
Because there are a large number of taps (typical 15 to 32), this test would 
normally take a very long time. With the MTO, this test time is drastically 
reduced because the instrument will stay on while changing “On load” tap 
positions.  

All regulators have internal bridging reactors. It is because of these reactors that 
stabliization time for the MTO will vary. On odd position taps, balance time will 
be longer than even positions. This is due to circulating current generated when 
on odd positions and is shown below: 

 

Figure 7: Odd Position Tap 

 

Figure 8: Even Position Tap 
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Figure 9:  Connection to a Regulator  

F WARNING 
Do not disconnect leads until all indicators are OFF. 

PROCEDURE 

1. Connect line cord to unit and plug into 120/240V socket. 

2. Set the following conditions: 

a 

 

Set to TEST position. 

b.  

 

Set to desired max test current. 

c.  

 

Set DATA OUTPUT MODE. 
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3. Connect "V1" voltage leads to test specimen winding. See Figure 9. 

4. Connect current leads (I) to test specimen winding. Do not clip voltage 
leads on to the current leads, since this will add contact resistance to the 
measurement. Voltage leads should always be placed inside 
(between) the transformer and the current leads. See Figure 9. 

5. Turn power switch "ON" (-). 

6. Press  button to initiate current flow.  

7. The top display indicates current output and Ohm 1 display indicates 
resistance. 

8. Step thru the TAPS of the “On load” tap changer. The resistance should 

change slightly with each TAP change. Press  to save and/or print 
the readings of each tap. 

If a Break Before Make condition occurs the Break Before Make Indicator 
will flash rapidly. 

 

Depending on the length of the break, one of two things will happen. 

1. For small breaks, the unit will rapidly flash, but the system will continue 
to operate and give resistance readings. 

2. For breaks longer than 10msecs, the system will automatically shut down. 
The HV Indicator will extinguish and the Discharge Indicator will flash. 

To extinguish the Break Before Make Indicator after an event, press . 

If no such condition exists the Remote Indicator will start slow flashing again 
until the circuit stabilizes from the tap change and then go steady when this 
setting has stabilized. 

3. Press  to record the reading again and the process continues until all 
transformer taps are tested. 



Transformer Testing 
 

 
AVTMTO210 Rev 7 Sept 2013 

39 

4. When measurements are complete, press  to terminate and 
discharge current. Discharge is complete when the discharge indicator is 
off. 

Demagnetizing a Transformer 

The MTO demagnetizes the transformer by automatically magnetizing the core 
of the transformer in the positive and negative direction with multiple cycles of 
reduced current. The demagnetization function is equivalent to generating test 
currents for multiple resistance tests. During the demagnetizations cycle, the unit 
will display the number of cycles left in the process.  

1. Demagnetization only needs to be accomplished once after all testing is 
complete.  

2. CURRENT and VOLTAGE leads should be attached to one phase/terminal 
pair on high side (Primary) windings for more effective demagnetization.   

3. Voltage Leads need to be attached. Just like a test. Discharge energy is 
absorbed through the voltage leads. 

4. Only one Winding needs to be demagnetized on a three phase transformer. 
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6 
MTO210 Series PowerDB Lite 

Introduction 

PowerDB Lite is a free, but limited capability, version of the PowerDB software 
tool that is designed specifically to control and/or extract data from Megger 
instruments. The primary difference between PowerDB Lite and PowerDB is 
that PowerDB is designed to work with all manufacturers’ equipment and has 
field and office synchronization capabilities. PowerDB Lite will present your test 
data into a professional looking data form that can be sent to a printer or .pdf file 
distiller such as PDF995. 

PowerDB Lite allows you to use a sub-set of the standard PowerDB forms that 
are appropriate for specific Megger instruments. PowerDB Lite detects the 
instrument and enables the appropriate form(s). Data can be entered on-screen 
or captured directly while using the test instrument. Completed data forms can 
be saved as files to your computer. 

For more information, or updates to the software, visit www.PowerDB.com. 

Minimum Recommended System  

 Operating System: Windows 2000 or later 

 RAM: 64 MB RAM minimum, 512+ MB RAM recommended  

 Processor: 300 MHz Pentium Class processor minimum, 1 GHZ or better 
recommended  

For information about the features of the full version of PowerDB please visit 
our website at www.powerdb.com. Get acquainted with the following features by 
scheduling a live demonstration at info@powerdb.com. 

 Synchronize all of your test records into a Single Corporate Database 

 Reduce Test Time 

 Improve Data Integrity 

 Standardize Test Procedures 

 Easily use Historical Trending for evaluation of Test Results 



M 
 

AVTMMTO210 Rev 7 Sept 2013 
42 

 Eliminates the need to install and maintain a software application per 
instrument 

 Eliminates all hand written test sheets 

 Create your own test forms 

 Use or modify one of our 200 built-in test forms 

 One-step procedure to generate test reports with table of contents and 
deficiency summaries 

 Allows all of your field test data to be integrated with CMMS systems such as 
Maximo or SAP 

 Imports >From Many Other Industry Standard Software Applications 

 Controls and Imports Data from many non-Megger Instruments 

Software Installation 

To install PowerDB Lite, load the PowerDB Lite CD into your CD-ROM drive 
and follow the on-screen instructions.  

1. Accept the terms of the License agreement.  
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2. Choose the destination location for the PowerDB Lite files. 

 

 

 

3. Select Default Settings.  
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4. InstallShield Wizard will complete the installation of PowerDB Lite. 
Click Finish to close the installation program. 
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Using PowerDB Lite  

1. HOME 

1.  Select your Instrument MTO210 from the Instrument Setup screen. 

a. You can always view the Instrument Setup screen from the Tools 
menu or F3. 

 
b. The MTO uses serial communication. Select the appropriate 

communication settings on the Serial Device Configuration screen.  

c. Use the Refresh button to find any ports that may have not been 
connected at the startup of PowerDB Lite. If you are using a USB 
serial port and do not know the port assigned to it please perform the 
following: 

1. Remove the USB serial adapter. 

2. Press Refresh. 

3. Click on the Port Drop Down and record the options. 

4. Plug the adapter back in. 

5. Press Refresh. 

6. Select the port that was not in the original list. 

Verify that the baud rate is set to 9600, Parity is set to none, Byte Size is set to 8, 
and Stop Bits is set to 1.  
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d. Click OK on the Instrument Setup Screen to finish.  

2. SELECT A FORM 

Once you have defined the instrument, PowerDB will present the forms created 
in the database and associated with that instrument. The factory default form is 
56352. 

 



MTO210 Series PowerDB Lite 
 

 
AVTMTO210 Rev 7 Sept 2013 

47 

3. ENTER TEST DATA 

a. Header and nameplate information can be manually typed into a 
form. 

b. Download Test Data – Pressing this screen button will 
automatically download all of the data from the MTO. 

c. Delete Selected Records – When PowerDB Lite is connected to 
the MTO, the user can select tests from the list of displayed 
downloaded tests and delete those specific tests. 

d. Delete ALL Test Data – When this software button is pressed, all 
of the data in the instrument will be deleted. 

 

4. COMMENTS AND DEFICIENCIES 

When imported into the full version of PowerDB, the comments and 
deficiencies on each form are used to generate summary reports. These summary 
reports repeat the notations and lists the page number where reported. This 
allows the user to scroll to a particular page to view a reported anomaly. For 
more information on features of PowerDB visit us at our website at 
www.PowerDB.com.  
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5.  SAVE THE DATA 

a. Select the File>Save menu item, or press CTRL+S, or press the Save 
toolbar button. 

b. The Save As screen will allow you to specify a location and file name 
for your PowerDB Lite XML file.  
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 6. OPENING AN EXISTING FILE 

a. Select the File> Open menu item. 

 
b. Browse to the file you would like to open. 

c. Press the Open dialog button. 

d. If the file contains multiple test dates, select the Date that you would 
like to open for editing or select New to append a new set of results 
to the file. To remove a set of results, click on the selected file and 
press the Delete button.  
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7. SETTING THE LOGOS 

a. Select the Tools>Options menu item.  

b. The Logos section specifies paths to the left and right logos files to 
use.  

c. To change the left logo press the “…” button by the left logo path. 

d. The Open Screen allows you to browse to a file location, select a 
.JPG or .BMP file, and press the Open button.  

e. Repeat steps (c) and (d) for the right logo path.  

f. Note that a logo will not be shown if the logo file path is blank or the 
file does not exist. 

g. Note after specifying the logo files the image will not be shown until 
the next time a form is opened (File>Open, or the File>New menu 
items). 

h. Note that the logos will look the best if the resolution of the file is 
240 pixels wide by 240 pixels high. DPI is not important. 
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8. HOW TO CHANGE LANGUAGES 

a. Select the Tools>Options menu item. 

b. Select the appropriate language in the dropdown menu.  

 

9. HOW TO CHANGE UNITS OF MEASUREMENT 

a. Select the Tools> Options menu item. 

b.  Select the units in the drop down Default Units under Measurements. 
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10. ADDITIONAL NOTES 

a. Additional forms can be filled out by repeating steps 2, 3 and 6. 

b. Forms can be printed with the File>Print menu item, or type 
CTRL+P, or press the Print toolbar button.  

c. A help guide may be found in the Help>PowerDB Lite Help menu 
item. 

Frequently Asked Questions (FAQ’s) 

1. Can I change the forms? 

No. You must have the full version of PowerDB to change forms.  

2. Can I synchronize forms to a database? 

No. You must have the full version of PowerDB for database support and to 
synchronize multiple field databases to a single master database. 

3. Can I import PowerDB Lite files into PowerDB? 

Yes. You can use the File>Import menu item in PowerDB to import files from 
PowerDB Lite.  
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7 
Service 

Maintenance 

Maintenance should be performed only by qualified persons familiar with the 
hazards involved with high-voltage test equipment. Read and understand Section 
2, Safety, before performing any service.  

Routine maintenance is required for the MTO test set.  

The appearance of the MTO test set can be maintained by occasionally cleaning 
the case, panel and cable assemblies. 

1. Clean the outside of the carrying case with detergent and water. Dry with 
a clean, dry cloth. 

2. Clean the control panel with a cloth dampened with detergent and water. 
Do NOT allow water to penetrate panel holes, because damage to 
components on the underside may result. An all-purpose, household 
spray cleaner can be used to clean the panel. Polish with a soft, dry cloth, 
taking care not to scratch the display screen cover. 

3. Clean the cables and mating panel receptacles with isopropyl or 
denatured alcohol applied with a clean cloth. 

4. Inspect the cable assemblies occasionally to ensure they are in good 
condition. 

Fuse Replacement 

The electronic circuits in the MTO test set are protected by two mains fuses. 
Fuse replacement is indicated if the electronic circuits do not function. Refer any 
fuse replacement to qualified personnel. To avoid electric shock and fire hazard, 
use only the fuses specified in Section 8, Parts List and Optional Accessories that are 
identical in respect to type, voltage rating, and current rating. Note that 2 spare 
fuses are included with each MTO.  

WARNING 
Before replacing the fuses, disconnect the 

power input plug from the live power source. 
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To replace fuse(s), proceed as follows: 

1. Disconnect the power cord from the MTO test set. 

2. Using a small flathead screwdriver, carefully remove the fuse holder of 
the input power module installed on the right side of the MTO test set 
front panel. 

3. Remove and properly dispose of blown fuse(s). 

4. Install new fuse(s) making sure to use the type specified in Section 8. 

5. Reinstall the fuse holder in its receptacle in the input power module. 
Connect the power cord to the MTO test set and to an energized power 
source. If the electronic circuits still do not function properly, contact the 
factory for service. 

 

Calibration 

A complete performance and calibration check should be made at least once 
every year. This will ensure that the MTO test set is functioning and calibrated 
properly over the entire measurement range. The MTO calibration is performed 
on each new or repaired unit before sending it to a customer. There is a special 
MTO final calibration procedure which requires a NIST-traceable test equipment 
to be used. As a result of such calibration procedure, each MTO test set may be 
NIST certified.  
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Repairs 

Any service or repair of this equipment should only be performed by qualified 
persons who are aware of electrical hazards and the necessary precautions 
required to prevent injury. 

Megger offers a complete Repair and Calibration Service and recommends that 
its customers take advantage of this service for routine maintenance or in the 
event of any equipment malfunction. 

In the event that Service is required, contact your Megger representative for a 
product Return Authorization (RA) number and shipping instructions. 

Ship the product prepaid and insured and marked for the attention of the 
Megger Repair Department. Please indicate all pertinent information, including 
catalog number, serial number, and problem symptoms. 
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ERROR CODES 

MTO comes with a wide range of error codes to assure unit is working properly 
and track down problems in a systematic manner. When an error code occurs, 
the first thing to do is acknowledge the error by pressing enter and repeating the 
test. If the error persists, review the possible causes and determine if you can 
resolve the problem on site. If the basic cause a ruled out, contact Megger for 
additional assistance. Bold Error codes are quite common with the possible 
causes defined. 

CODE Error Description Possible Cause 

ESd ESD is pushed down  Button is pushed down, internal cable is 
disconnected, internal hardware failure 

IntLoc Interlock interface is open Interlock Jumper removed, attached 
interlock circuit broken, internal cable 
disconnected 

1XX Ethernet and top panel errors (MTO210 
ONLY) 

 

101 No link between top panel and lower 
acquisition board 

 

102 Ethernet communication failed  

110 Current selection switch error  

111 Function Mode switch error  

112 Storage Mode Switch errors  

113 I2C BUS error  

114 LCD I2C bus error  

115 LED I2C bus error  

116 MUX I2C bus error  

117 EEPROM failure  

2.0  Initialization error  

201 ADC internal zero calibration failure  

202 ADC internal full-scale calibration failure  
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CODE Error Description Possible Cause 

203 Onboard 5 volt supply out of range, too 
high 

 

204 Onboard 10 volt out of range, too high  

205 Onboard 28 volt out of range, too high  

206 VICOR power supply temperature is out of 
range 

 

207 Discharge circuit temperature is out of 
range 

 

208 2.5V reference is out of range  

209 Zero reference is out of range  

210 25V reference is out of range  

211 VICOR power supply failed to regulate at 5 
volts 

 

212 VICOR power supply failed to regulate at 
20 volts 

 

213 VICOR power supply failed to regulate at 
40 volts 

 

214 EsD  

215 VICOR power supply control loop circuit 
failed 

 

216 Too much voltage ripple for the 5 volt 
supply 

 

217 Too much voltage ripple for the 10 volt 
supply 

 

218 Too much voltage ripple for the 28 volt 
supply 

 

221 Too much voltage ripple for the 2.5 volt 
reference 

 

222 Too much voltage ripple for the 25 volt  
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CODE Error Description Possible Cause 

reference 

223 Too much voltage ripple for the VICOR 
power supply at 5 volts 

 

224 Too much voltage ripple for the VICOR 
power supply at 20 volts 

 

225 Too much voltage ripple for the VICOR 
power supply at 40 volts 

 

226 UNDER status input failed  

227 OVER status input failed  

228 EEPROM byte writing error  

229 EEPROM byte reading error  

230 EEPROM is uninitialized  

231 Discharge temperature too much ripple  

232 VNOISE voltage out of range  

233 VNOISE voltage too much ripple  

234 VICOR power supply failed at 5v, voltage 
too high 

 

235 VICOR power supply failed at 5v, voltage 
too low 

 

236 VICOR power supply failed at 20v, voltage 
too high 

 

237 VICOR power supply failed at 20v, voltage 
too low 

 

238 VICOR power supply failed at 40v, voltage 
too high 

 

239 VICOR power supply failed at 40v, voltage 
too low 

 

240 VICOR power supply failed at loop test, 
voltage too low 
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CODE Error Description Possible Cause 

241 Onboard 10v out of range, voltage too low  

242 Onboard 28v out of range, voltage too low  

243 Discharge temperature is out of range, too 
high 

Unit overheated, fans filters clogged, fans 
not working, overuse, extremely hot test 
conditions 

244 VICOR temperature is out of range, too 
high 

Unit overheated, fans filters clogged, fans 
not working, overuse, extremely hot test 
conditions 

245 VNOISE voltage out of range, too low.  

246 VICOR temperature too much ripple  

3.0 ADC_ERROR  

301 ADC reading times out or ADC locks up  

302 Internal error. Communication with ADC 
failed. 

 

303  ADC sample rate setting failed  

304  ADC internal zero cal failed  

305 ADC internal full-scale calibration failed  

306 ADC cannot be restored back to normal 
mode 

 

307 ADC channel 1 selection failed  

308 ADC channel 2 selection failed  

309 ADC channel 3 selection failed  

310 Too much noise/ripple on ADC readings  

311 ADC failed, initialization  

312 ADC failed, run time  

313 ADC locks up, can not read  
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CODE Error Description Possible Cause 

314 ADC channel 4 failed  

4.0 HARDWARE_ERROR  

401 Discharge takes too much time  

402 VICOR protection failed, OVER is too long 
or too short to reset 

 

403 VICOR protection failed, OVER is too long 
or too short to set 

 

404 VICOR fast protection failed, OVER is too 
long or too short to reset 

 

405 VICOR fast protection failed, OVER is too 
long or too short to set 

 

406 Current Regulation failed at DAC=0  

407 Current Regulation failed at 10mA range  

408 Current Regulation failed at 100mA range  

409 Current Regulation failed at 1A range  

410 Current Regulation failed at 10A range  

411 Current output not high enough  

412 Too much ripple for Lamp On  

413 Too much ripple for Lamp Off  

414 Test Lamp voltage is too low  

415 Test Lamp voltage is too high  

416 Warning Lamp test failed  

417 Remote lamp test failed  

418 Relay test K1 on and K2 on failed   

419 Relay test K1 off test failed  
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CODE Error Description Possible Cause 

420 Relay test K2 off test failed  

421 Relay test K3 on and K4on failed  

422 Relay test K3 off test failed  

423 Relay test K4 off test failed   

465 OVER and UNDER failed during winding 
resistance test 

 

466 Current calibration failed during winding 
resistance test 

 

467 Voltage calibration failed during winding 
resistance test 

 

468 Received abort signal  

469 System zero cal failed during current 
regulation 

 

470 No current setting has been set for current 
control. 

 

471 Current is flat or dropping while charging Current leads not connected 

472 Break before make error Lead removed during testing. >10% current 
change during testing. 

473 H1+ failed, Vrelay3 failed  

474 X3+ failed, K9 failed  

475 I-SENSE failed  

476 Auto-range, resistance is too high  

477 Auto-range, current failed  

478 Auto-range, current standard deviation too 
high 

 

479 Auto-range, voltage is too low  
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CODE Error Description Possible Cause 

480 Current = 0  

481 Over didn't stay set for normal transistor 
protection test 

 

482 Over didn't stay set for fast transistor 
protection test 

 

483 Transistor protection med-low failed, 
OVER is too short to reset 

 

484 Transistor protection med-low failed, 
OVER is too short to set 

 

485 Fast transistor protection high failed, 
OVER is too short to reset 

 

486 Fast transistor protection high failed, 
OVER is too long to set 

 

487 Fast transistor protection high failed, 
OVER is too short to set 

 

488 Current Regulation failed at 10mA range, 
too low 

 

489 Current Regulation failed at 100mA range, 
too low 

 

490 Current Regulation failed at 1A range, too 
low 

 

491 Current Regulation failed at 10A range, too 
low 

 

492 Relay K1 and K2 failed, current too low  

493 Relay K3 and K4 failed, current too low  

494 ESD Abort signal encountered Switch pushed down during test 
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8 
Parts List and Optional Accessories 

Item Cat. No. 

Transformer Ohmmeter 

120/230 volt, 50/60 Hz input 

MTO210 

 

INCLUDED ACCESSORIES 

V1 Potential lead set, 60 ft (18 m)  2000-700  

V2 Potential lead set, 60 ft (18 m)  2000-701  

Current lead set, 60 ft (18 m)  2000-702  

Shorting lead, 30 ft (9 m) [1]  2000-703  

Ground lead, 15 ft (4.6 m) [1]  4702-7  

Remote trigger switch  30915-220  

AC power cord (IEC60320-C13 to US standard)  17032  

AC power cord (IEC60320-C13 to Schuko CEE 7/7)  17032-13  

Serial Data Cable  CA-RS232  

In-lid Quick Start Guide  37178  

Canvas carrying bag (for leadsets)  30915-211  

Instruction manual  ATVMMTO210  

PowerDB LITE software  DB0001  

Fuse 3.15A, 250V, 5x20mm, SLO BLOW  27708-7  

Fuse 6.3A, 250V, 5x20mm, SLO BLOW  90001-167  

 

OPTIONAL ACCESSORIES 

 

Beacon strobe light  37181  

Printer (includes battery/line powered serial thermal printer, 
printer interface cable)  

   

120 V, 60 Hz  1001-390  

230 V, 50 Hz  1001-401  

Foam-lined transit case  37009  

PowerDB (full version) software,1st machine license, soft key  DB1001  

PowerDB (full version) software,  

1st machine license, USB dongle  

DB1001S  
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9 
Specifications 

INPUT 120/230 V, 50/60 Hz, 750 VA 

OUTPUT  

User Selectable Current Ranges: up to 10 mA 

 up to 100 mA 

 up to 1 A 

 up to 10 A 

Test Voltage: up to 50 Vdc 

RESISTANCE MEASUREMENT/DISPLAY  

Resistance: @ 10A 1 μΩ to 2Ω  res. 0.1 uΩ 

@ 1.0A 10 μΩ to 20Ω  res. 1.0 uΩ 

@ 100mA 100 μΩ to 200Ω  res 10 uΩ 

@ 10mA 1.0 mΩ to 2000Ω  res 0.1 mΩ 

Accuracy: ±0.25% reading, ±0.25% full scale  

Resolution: 4 digits 

Displays Two 1’’ high, 6 character, 7-segment, LCDs 
One 0.71” high, 6 character, 7-segment, LCD 

PRINTER Via RS-232 port 

USER INTERFACE B&W numeric displays, keypad 

COMPUTER INTERFACE 
(for downloading results) 

Via RS-232 port 

INTERNAL DATA STORAGE Up to 2,000 data sets (256Kbytes) 

ENVIRONMENTAL  

Operating: 14° F to 122° F (-10° C to 50° C) 

Storage: 5° F to 158° F (-15° C to +70° C) 

Relative Humidity: 0-90% non-condensing 

DIMENSIONS 8.5 H x 21.5 W x 13 D  
(216 H x 546 W x 330 D mm) 

WEIGHT Net 29 lb (13.1 kg) 
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